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Module 8:  Using Maps 

When your customer asks you, “Which hotels are closest to…?” or “Can I 
walk from my hotel to…?”, you can use the map tool to assist you in 
answering these types of questions.   

Note: The map tool is optional; your agency must subscribe in order for you 
to use it. 

Module Objectives 

Upon completion of this module, you will be able to: 

• Display hotels and attractions on a geographical map from a Hotel 
Availability or Hotel Index display. 

• Find the approximate distance between two or more points on a map. 

• Display a map using a booked segment. 

• Display a map from the itinerary window by searching for a city or 
reference point. 

• Create and display custom reference points for a map. 
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Maps 

With the maps tool, you can display a geographical map of an area and plot 
hotels, attractions, and suburban cities.  You can also create your own 
reference points and plot them on the maps. 

Below is an example of a map displayed from Hotel Availability showing the 
hotels in downtown Chicago. 

 

The right pane of the map window lists the names of the hotels that are 
plotted by number on the map. 
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You can display the name of a hotel by moving the pointer over one of the 
numbers on the map and holding it there a few seconds.  The example below 
shows the pointer over number 10, the Holiday Inn Mart Plaza (Martplz). 

 

From a map display, you can do a number of things including: 

• Plotting hotels, attractions, custom reference points, and suburban cities 

• Check hotel availability and sell hotels 

• Find the distance between two or more points 

Note:  Many of the map functions require the use of a mouse.  

Pointer over 
number 
displays name 



Module 8: Using Maps   

8.4 Booking Cars and Hotels using Viewpoint™ Course Book, February 2004 

The following example shows the Superdome in New Orleans selected from 
the list of attractions and plotted on the map along with area hotels. 

 

The example below shows that the approximate distance between the 
Superdome (#12) and the Hotel New Orleans (#4) is four tenths of a mile. 

 

Distance  
for plotted 
points  

Plotted 
points 

Attraction 
also plotted 
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Using Viewpoint™, you can display a map several different ways: 

• From a Hotel Availability or Hotel Index display 

• By selecting a booked hotel, car, or air segment 

• By searching for a city or reference point  

Each of these methods is described in the following pages. 

Display Maps from Hotel Availability or Index 

You can easily display a map of hotels from a Hotel Availability or Hotel 
Index display.  You might display a map of hotels if you are working with a 
customer who is asking you specific questions about the location of a hotel. 

When you request a map from a Hotel Availability or Hotel Index display, all 
hotels in the display are plotted on the map.  If your customer is only 
interested in one or two hotels, you can mark them before requesting the map 
display so they appear differently from the others.  You can also mark them 
after the map is displayed. 

The example below shows three New Orleans hotels marked on a Hotel 
Availability display.  

 

Checkmarks 
Indicate 
marked hotels 
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The marked hotels appear differently from the others on the map. 

 

When to Use 

From a Hotel Availability or Hotel Index display, request a map to answer 
questions from your customer about the location of one or more hotels. 

How to Use 

To display maps, use the following steps. 

1. Double-click each hotel on the Hotel Availability or Hotel Index display 
that you want to be highlighted when the map is displayed. 

A checkmark appears at the beginning of the line.  To uncheck a hotel, 
double-click the hotel line again. 

2. Click the Map button on the toolbar and select View Map for Marked 
Properties.  

The map appears.  All of the hotels that are plotted on the map are listed 
with corresponding numbers in the right pane of the window. 

The hotels that you selected display in a square box with a red border 

similar to the following:  

Continued on next page 

Marked hotels 
highlighted 
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How to use (Cont.) 

3. From the map display, you can perform a number of tasks including the 
following: 
− To plot additional hotels from the Maps display, double-click a name 

from the list in the right pane. 
− To plot attractions, custom reference points, or suburban cities: 

a. Click the Plot down arrow and select a category.  A list of items 
appears. 

b. Double-click the item(s) to be plotted on the map. 

Note:  Before you can plot custom reference points, you must create 
them.  

− To change the view of the map, click the Zoom button on the toolbar 
and click one of the available options (Zoom in, Zoom out, East, 
West, etc.).  The options that are available may be different 
depending on the city or area that the hotels are located in.  

− To  sell, display complete availability, or display a description for one 
hotel: 
a. Select a hotel by clicking its number on the map or clicking its 

name in the list. 
b. Click Sell, or click the Information button on the toolbar and 

select Complete Rates for Selected Hotel or Description for 
Selected Hotel. 

− To  check availability for all hotels or only hotels that are marked, 
click the Information button on the toolbar, select Check Availability 
and select Marked Hotels or Selected Hotels. 

4. To close the map window, click Close Window. 

Determine Distance Between Points 

When your customer asks, “How far is it...?”, you can display a map and get 
the answer using one of the map tools.  Distance can be displayed in miles or 
kilometers.  

After displaying a map, you can find the distance between two points or 
more than two points. 

Note: This requires you to use your mouse. 

When to Use 

Display the distance between two or more points after you have displayed a 
map. 
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How to Use 

To find the distance between two points on a map, complete the following 
steps: 

1. Plot any hotels, custom reference points, attractions, or suburban cities. 

2. Click the Distance button and select Miles or Kilometers. 

3. Do any of the following: 
− To display the distance between only two points: 

a. Click the Distance button and select Distance.  The pointer icon 
changes. 

b. Move the pointer over the first point. 
c. Click the mouse button, and while holding the mouse button 

down, move the pointer to the second point. 
d. Release the mouse button. 

− To display the distance between more than two points: 
a. Click the Distance button and select  Joint Distance.  The pointer 

icon changes. 
b. Move the pointer over the first point, and click the mouse button. 
c. Move the pointer over the next point, and click the mouse 

button.  Repeat this for as many points as desired. 

The distance between the two points is displayed in the upper left corner 
of the map.  

4. To exit from the distance tool, double-click anywhere on the map.  

The pointer changes back to its original icon. 

Practice 

You are working with a customer who wants to book a hotel near the Art 
Institute in downtown Chicago six months from now. 

1. Search for hotels within a mile of the Art Institute of Chicago. 

2. Mark the first, third, and fifth hotels for plotting on a map. 

3. Display the map. 

4. Plot the Art Institute of Chicago on the map. 

5. Your customer asks how far the Art Institute is from Union Station.  Find 
the distance between these two points. 
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Display a Map using a Booked Segment 

If your customer asks you questions about the location of hotel or driving 
distance from the airport to downtown after you’ve already booked an air, 
car, or hotel segment, you can use those booked segments to quickly display 
a related map to answer the questions. 

The map in the example below was displayed from a booked hotel segment.  
Only the booked hotel is plotted on the map.  

 

When to Use 

Use a booked air, car, or hotel segment to display a map that relates directly 
to that segment to help answer any customer questions. 

How to Use 

To display a map that relates to a booked segment, use the following steps. 

1. Select a booked air, car, or hotel segment on the itinerary window. 

2. Click the Map button on the toolbar and select Display Map. 

The map window appears. 

Booked 
hotel plotted 
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Search for a Map 

You can search for a map using a city, reference point or postal code.  You 
can also display maps of selected airports. 

To search for maps, you use the Map Search dialog box.  You can display 
this dialog from the Map button on the toolbar or Map menu. 

Searching for a map using the Map Search dialog is a two step process:  

1. Enter or select information on the top part of the dialog box to narrow 
your search down to an area. 

2. Select a specific map from the results of Step 1 in the bottom part of the 
dialog box. 

Enter a City or Reference Point 

To search by city or reference point, you type a name in the entry box.  The 
search begins as soon as you stop typing.  Depending on what you have 
entered, there may be an exact match or several matches. 

If there is an exact match on what you typed, a selection of maps will appear 
in the bottom half of the dialog box.  For example, when ‘French Quarter’ is 
typed, there is an exact match. 

 

Continued on next page 
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Enter a City or Reference Point (Cont.) 

Maps matching your search are displayed in the lower half of the dialog box.  
You can expand any areas that have plus signs (+) in front of them.  Select a 
map by clicking it, and then click OK. 

If there are several matches, a list of entries appears directly below the entry 
box.  You must select one of the entries matching your search before 
selecting a map. 

For example, if you type ‘new york’, there are several matches. 
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Search by Airport 

Click the Airport tab to search for an airport.  Select an airport from the drop 
down list.  Then click OK. 

 

Below is the map of Atlanta’s Hartsfield International airport. 
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Enter a Postal Code 

Use the Postal Code tab to search for maps by postal code.  Type the five-
digit postal code to begin the search.  The search begins as soon as you type 
the fifth number. 

 

Select a map and click OK to display the map. 
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Custom Reference Points 
 

If your customer travels to an office or client occasionally, but doesn’t have 
any hotel preference, you can create a custom reference point to plot the 
office on a map to remind you of its location. 

For example, your customer visits his client, DCS Enterprises, in downtown 
St. Louis a few times a year.  You create a custom reference point to mark 
where the office is in downtown St. Louis. 

 

Create Custom Reference Points 

When to use 

Create a custom reference point when you want to be able to plot something 
on a map that isn’t listed in the hotels, attractions, or suburban city 
categories.  

How to use 

To create a custom map, use the following steps. 

1. Display the map on which you want to create a custom map. 

2. From the Map menu, select Insert Custom Reference Point. 

The cursor icon changes. 

Custom 
reference 
point 
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3. Move the pointer over the point at which you want the custom reference 
point to display on the map and click the mouse button. 

Note:  The custom reference point is plotted where the pointer’s arrow 
tip is pointing. 

The Custom Reference Point dialog box appears. 

4. Complete the fields on the Custom Reference Point dialog box. 

Note: the Reference Point Name is required.  It is the name that will 
display in the right pane of the map window. 

5. Click OK. 

The custom reference point is saved and plotted on the Map. 

Note:  To clear a custom reference point from displaying on the map, 
right-click on its name and select Clear. 

 Change Custom Reference Points 

Once you’ve created a custom reference point, you can make changes to the 
name or address information. 

Note:  In order to change where the custom reference point is plotted, delete 
it, and the recreate it. 

When to use 

Change a custom reference point when the name changes or you no longer 
need it.  

How to use 

To change or delete a custom point, use the following steps. 

1. From a map display, select Manage Custom Reference Points from the 
Options menu. 
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The Manage Custom Reference Points dialog box appears.  

 
Note: By default, only custom reference points for the current map are 
listed.  To list custom reference points for all maps, click List All Points. 

2. Do one of the following:  
− To change the name or address information: 

a. Click the custom reference point to be changed in the name 
column. 

b. Click Edit.  The Custom Reference Point dialog box appears. 
c. Edit the information and click OK.  

− To delete the custom reference point: 
a. Click the custom reference point to be deleted in the name 

column. 
b. Click Delete.  A confirmation dialog appears. 
c. Click Yes.  The custom reference point is removed from the 

dialog box. 

3. To close the Manage Custom Reference Points dialog box, click Close .  
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Practice 

1. Search for a map of South Lake Tahoe.  Display the map. 

2. Add the custom reference point, ‘Heavenly Resort’, to the lower right 
portion of the map, somewhere near where Saddle and Wildwood roads 
intersect.  Optionally, add a fictitious address and telephone. 

3. Display the name of your custom reference point by pointing to its 
number. 

4. Change the ‘Heavenly Resort’ custom reference point name to ‘Heavenly 
Ski Resort’. 
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Summary 

In this module you learned how to: 

• Display hotels and attractions on a geographical map from a Hotel 
Availability or Hotel Index display 

• Find the approximate distance between two or more points on a map 

• Display a map using a booked segment 

• Display a map from the itinerary window by searching for a city or 
reference point 

• Create and display custom reference points for a map 
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Module 9:  Adding Optional PNR Fields 

Optional PNR fields provide you with a way to include important data with 
your customer’s reservation. 

This module explains how to add these optional fields to a PNR. 

Module Objectives 

Upon completion of this module, you will be able to add remarks to a PNR. 

Add and Change PNR Remarks 

You can add a freeform note or message to a PNR.  There are several types 
of PNR remarks: 

• Associated—associated to a segment 

• Unassociated—unassociated to a segment 

• General—general information 

• Document/Invoice—designate the format of, or the items that need to be 
printed out on, an Itinerary/Invoice 

• Customer ID—customer remark. 

• Postscript—displays at the top of the PNR, but does not print on a ticket 
or itinerary 

• Queue Minder—place a PNR message onto a queue 

Continued on next page 
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Add and Change PNR Remarks (Cont.) 

You use the PNR Remarks dialog box to enter or change all types of 
remarks. 

 

Add Associated Remarks 

Associated remarks are itinerary remarks you create and associate to a 
specific segment in a PNR.  When you print an itinerary, associated remarks 
print immediately after the segments they reference.  You can have up to 70 
freeform characters per associated remark.   

Note:  When you add, change, or delete associated remarks, that information 
does not go into the PNR history. 

You can create a maximum of 1890 characters for combined associated and 
unassociated remarks. 
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Associated remarks display on the itinerary window as a part of the segment 
they are associated with.  Below is an example of a remark associated with 
segment 2, a hotel segment. 
 

 

When to use 

Add an associated remark when you want to add information relating to a 
specific segment. 

How to use 

To add an associated remark, use the following steps. 

1. Click the Customer button on the toolbar, select Create/Edit Remarks, 
and select Associated from the menu. 

The Associated tab of the PNR Remarks dialog box appears.  By default, 
the first segment is selected. 

2.   Click the segment to which the remark will be associated. 

3.   Click the Remarks Text text box and type the remark. 

4.   Click Add. 

The remark is added to the Remarks text box, the top pane of the dialog 
box. 

5.   Click OK. 

The remark is added to the PNR. 

Associated 
Remark 
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Modify and Delete Associated Remarks 

When to use 

Modify or delete an associated remark when you need to make a change to a 
remark associated with a specific itinerary segment. 

How to use 

To modify or delete an associated remark, use the following steps. 

1. Click the Customer button on the toolbar, select Create/Edit Remarks,  
and select Associated from the menu. 

The Associated tab of the PNR Remarks dialog box appears. 

2. Click the segment that contains the associated remark that you want to 
change. 

The segment is highlighted and the associated remark(s) display in the 
Remarks text box. 

3.   Click the remark that you want to change or delete. 

The remark is highlighted. 

4.   Do one of the following:  
− To modify the remark, change the text in the Remark Text text box.  

Then click Modify. 
− To delete the message, click Delete. 
− Click OK. 

Add Unassociated Remarks 

Unassociated remarks are freeform remarks you create for an itinerary that 
do not associate to a specific segment.  When you print an itinerary, 
unassociated remarks display at the bottom of the itinerary.  You can have up 
to 70 freeform characters per unassociated remark.   

Note:  When you add, change, insert and delete unassociated remarks, that 
information does not go into the PNR history. 

The unassociated remark displays after the last segment on the itinerary.   
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Below is an example of an unassociated remark thanking the customer. 

  

When to use 

Add an unassociated remark when you want to add a remark that isn’t 
specific to any one segment. 

How to use 

To add an unassociated remark, use the following steps. 

1. Click the Customer button on the toolbar, select Create/Edit Remarks,  
and select Unassociated from the menu. 

The Unassociated tab of the PNR Remarks dialog box appears. 

2.   Click the Remarks Text text box and type the remark. 

3.   Click Add. 

The remark is added to the Remarks text box, the top pane of the dialog 
box. 

4.   Click OK. 

The remark is added to the PNR. 

 

 

Unassociated 
Remark 
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Modify and Delete Unassociated Remarks 

When to use 

Modify or delete an unassociated remark when you need to make a change. 

How to use 

To modify or delete an unassociated remark, use the following steps. 

1. Click the Customer button on the toolbar, 
select Create/Edit Remarks, and select 
Unassociated from the menu. 

The Unassociated tab of the PNR Remarks dialog box appears. 

1. Click the remark that you want to change or delete. 

The remark is highlighted. 

2. Do one of the following:  
− To modify the remark, change the text in the Remark Text text box.  

Then click Modify. 
− To delete the message, click Delete. 
− Click OK. 

 Add General Remarks 

General PNR remarks are an optional way for you to keep notes about the 
record in Apollo®.  These are freeform remarks and do not print on any 
documentation or transmit to any airline. 

How you add, modify, and delete a general remark is similar to doing the 
same with unassociated remarks. 

You can add a single-character qualifier to the general remark so that you can 
sort the remarks on the itinerary window.  Preface your remark with a 
qualifier letter followed by a slash.  For example, to add a qualifier for a 
hotel remark you would enter ‘H/REMARK’. 
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General PNR remarks display in the Remarks and Service Information 
section on the itinerary window.  If you’ve added qualifiers, you can sort 
them by right-clicking over any general remark and selecting Sort by 
Qualifier. 

 

When to use 

Add a general remark when you want to note something about the PNR that 
will not print or be transmitted to a vendor. 

How to use 

To add a general remark, use the following steps. 

1. Click the Customer button on the toolbar, select Create/Edit Remarks,  
and select General from the menu. 

The General tab of the PNR Remarks dialog box appears. 

2.   Click the Remarks Text text box and type the remark. 

Note:  To add a qualifier, preface your remark with a letter and slash 
(e.g., C/remark). 

3.   Click Add. 

The remark is added to the Remarks text box, the top pane of the dialog 
box. 

3. Click OK. 

The remark is added to the PNR. 
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Modify and Delete General Remarks 

When to use 

Modify or delete a general remark when you need to make a change. 

How to use 

To modify or delete a general remark, use the following steps. 

1. Click the Customer button on the toolbar, select Create/Edit Remarks,  
and select General from the menu. 

The General tab of the PNR Remarks dialog box appears. 

2.   Click the remark that you want to change or delete. 

The remark is highlighted. 

3.   Do one of the following:  
− To modify the remark, change the text in the Remark Text text box.  

Then click Modify. 
− To delete the message, click Delete. 
− Click OK. 

Add Document/Invoice Remarks 

Document/Invoice remarks are frequently used itinerary remarks pre-stored 
in a file created and maintained by the agency secondary authorizer.  You 
can choose remarks from the file and use them on a customer’s itinerary. 
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Document/Invoice remarks display in the Document/Invoice Remark section 
of the itinerary window as shown in the example below. 

 

When to use 

Add a document or invoice remark when you want to designate items to be 
printed out on an itinerary or invoice. 

How to use 

To add a document or invoice remark, use the following steps. 

1.    Click the Customer button on the toolbar, select Create/Edit Remarks, 
and select Document/Invoice from the menu. 
 
The Document/Invoice tab of the PNR Remarks dialog box appears. 

2.    Click the remark in the Invoice Remarks text box that you want to add.   
The remark is highlighted and information on how to complete the 
remark appears in the Hint area (right side of the dialog box).   

3.    Click in the text box above the Add button and type the appropriate 
information. 

4.    Click Add. 

The remark is added to the Invoice Remarks text box. 

5.    Click OK. 

      The remark is added to the PNR. 
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Modify and Delete Document/Invoice Remarks 

When to use 

Modify or delete a document/invoice remark when you need to make a 
change. 

How to use 

To modify or delete a document/invoice remark, use the following steps. 

1.   Click the Customer button on the toolbar, select Create/Edit Remarks, 
      and select Document/Invoice from the menu. 

      The Document/Invoice tab of the PNR Remarks dialog box appears. 

2. Click the remark in the Invoice Remarks text box that you want to 
change or delete. 

3.   Do one of the following: 
− To modify the remark, change the text in the text box.  Then click 

Modify. 
− To delete the remark, click Delete. 

3. Click OK. 

Add and Change Customer ID and Postscript Remarks 

You can add a customer ID and a postscript remark to the PNR.  You can 
enter only one customer ID and one postscript remark. 

The customer ID that you enter displays in the Names section on the 
itinerary.   

A postscript note is a freeform message you can add to a PNR.  It displays at 
the top of the PNR, but does not print on a ticket or itinerary.  A postscript 
note could act as a reminder to you that action is still required.  The 
postscript remark displays next to the record locator. 

When to use 

Add or change a customer ID or postscript remark when you want to display 
a customer ID or header remark on the PNR. 
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How to use 

To add or change a customer ID or postscript remark, use the following 
steps. 

1.   Click the Customer button on the toolbar, select Create/Edit Remarks, 
      and select Customer ID/Postscript from the menu. 

      The Customer ID/Postscript tab of the PNR Remarks dialog box appears. 

 

2.   Type the Customer ID and/or Postscript remark in the appropriate text 
      box. 

4. Click OK. 

The remark is added to the PNR. 

Add Queue Minders 

Apollo® queue minders help you with follow up work needed for a PNR, 
such as seat assignments and car and hotel reservations.  A queue minder is a 
note added to a PNR that places it in a queue on a specific date along with 
instructions on what needs to be done.  When you add, change, and delete 
queue minders, that information is then stored as PNR history. 

You can have up to 20 queue minders in one PNR.  Each queue minder can 
contain up to 64 characters, including a queue number, a date, and freeform 
text. 
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Queue Minders display in the Ticketing Arrangement section as shown in the 
following example. 

 

When to use 

Add a queue minder remark to place a PNR message onto a queue as a 
reminder for actions that need to be made to the booking in the future.   

How to use 

To add a queue minder remark, use the following steps. 

1.   Click the Customer button on the toolbar, select Create/Edit Remarks,  
      and select Queue Minders from the menu. 

      The Queue Minders tab of the PNR Remarks dialog box appears. 

2.    Type the date the message should go on queue or select one from the 
Calendar by clicking the down arrow. 

3.    Enter the Queue number and Category on which it should be placed. 

If required, enter the pseudo of the agency to which you want to queue.  
This facility is only available if you have the necessary agreements with 
an associated agency. 

4.   Type the message in the Text text box. 

5.   Click Add. 
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The remark is added to the Items text box. 

6.   Click OK. 

The remark is added to the PNR. 

Modify and Delete Queue Minders 

When to use 

Modify or delete a queue minder when you need to make a change.   

How to use 

To add a queue minder remark, use the following steps. 

1.   Click the Customer button on the toolbar, select Create/Edit Remarks, 
      and select Queue Minders from the menu. 

 
The Queue Minders tab of the PNR Remarks dialog box appears. 

2.   Click the queue minder remark in the Items text box that you want to 
      change or delete. 
 
3.   Do one of the following:  

− To modify the remark, change the information.  Then click Modify. 
− To delete the message, click Delete. 
− Click OK. 

 
Practice 

Use the PNR that you saved in Module 6 (Avis intermediate size in San 
Francisco). 

Associate the following remark to the car segment: HAVE A SAFE TRIP 

Add the following remark to the itinerary (unassociated):  THANKS FOR 
YOUR BUSINESS 

Add a queue minder for two days from now to queue 30: CHECK FOR 
UPGRADE AVAILABILITY 

Add the following postscript message:  APPROVAL PENDING 
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Summary 

In this module you learned how to add remarks to a PNR. 
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Module 10:  Working with PNRs 

Customers change their travel plans often.  You may need to view or change 
the PNR after saving it.  Viewpoint™ makes it easy to retrieve PNRs to 
accommodate your customers’ needs. 

This module describes how to retrieve a PNR.  It also explains how to work 
with more than one PNR at time and reorder itinerary segments. 

Module Objectives 

Upon completion of this module you will be able to: 

• Retrieve a PNR 

• Explain and use agent assembly areas (AAAs) 

• Reorder segments 

Retrieve PNRs 

After you save a PNR, you can retrieve it to view or make changes to it. 

You can retrieve a PNR using its record locator or by the first traveler’s last 
name.  If you choose to retrieve the PNR by last name, you can optionally 
enter additional information such as the departure date or flight number to 
narrow your search in the event there is more than one PNR with the same 
last name. 
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You use the Retrieve PNR dialog box to retrieve a PNR.  This dialog box has 
three tabs: 

• Name/Record Locator—used to retrieve a PNR by last name or record 
locator.   

• Flight—used to retrieve a PNR by airline, flight, date, and last name. 

• Selective Access—used to retrieve a PNR from another pseudo with 
Selective Access™. 

 

The most common methods of retrieving a PNR by last name and by record 
locator are documented below. 

Retrieve a PNR by Name 

When to use 

Retrieve a PNR when you want to view it or make changes to it. 
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How to use 

To retrieve a PNR by name or record locator, use the following steps. 

1. Click the Customer button and select Retrieve PNR. 

The Retrieve PNR dialog box appears. 

 
2. Type the last name of the first traveler in the Last Name text box.   

Note: If you are not sure how to spell the customer’s last name, or are 
only sure of the first few letters of the name, use a partial spelling plus a 
wildcard character (*) to display the PNR (e.g., “For*”). 

Optionally, you can complete the First Name text box to improve the 
search in the event there is more than one PNR with the same last name.   
 
You can also use the Date checkbox to enter the date of departure.  Use 
the drop down calendar to view the current month. 
 
Retrieve from all branches: If you have Selective Access™ agreements, 
click this checkbox to retrieve from all branch offices associated to your 
pseudo city.   
 
Branch Pseudo: Enter the pseudo city of a specific branch office 
associated to your pseudo city.  If you have Selective Access™ you can 
enter an alternative pseudo city. 

Continued on next page 
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How to use (Cont.) 

3. Click OK. 

If only one PNR matches the traveler name information you entered, the 
PNR is retrieved from the Apollo® system and displayed on the itinerary 
window. 

If more than one PNR matches the traveler name information you 
entered, the Similar Names List dialog box appears.  

 
4. To select a PNR from the Similar Names List, double-click it. 

Keyboard:  Use the Up and Down arrow keys to highlight the PNR, and 
then press Enter.   

Retrieve a PNR by Record Locator 

Retrieving a PNR by record locator is the most direct way of retrieving a 
PNR because a PNR’s record locator is unique within the Apollo® system.  

When to use 

Retrieve a PNR by record locator when you know it. 
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How to use 

To retrieve a PNR by record locator, use the following steps. 

1. Click the Customer button and select Retrieve PNR. 

The Retrieve PNR dialog box appears. 

2. Click the Record Locator radio button. 

The Retrieve PNR dialog box changes, displaying the Record Locator 
text box. 

 
3. Type the record locator, and then press Enter.   

The PNR is retrieved from the Apollo® system and displayed on the 
itinerary window. 

Practice 

Retrieve Chris Zachs’ PNR by name and cancel all segments.  Save the PNR. 
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Agent Assembly Areas 

You can work in five Agent Assembly Areas (AAA's).  The areas are 
identified as A, B, C, D, and E.  All five work areas can be active with 
different PNRs.  However, only one PNR can be active in any one work area.  
After signing on to Viewpoint™, you work in Area A until you change to 
another area. 

For example, you could work with three active PNRs: Jones in area A, 
Garcia in Area B, and Brown in Area C. 
 

 

 

Before you sign off of the Apollo® system, all AAA's must be free of 
incomplete PNRs (records not yet saved). 

Change Agent Assembly Area (AAA) 

When to use 

Change the Agent Assembly Area when you want to work with more than 
one PNR simultaneously. 

How to use 

To change the Agent Assembly Area, use the following steps. 

1. From the Tools menu, click Change Work Area. 

The Change Work Area / Duty Code dialog box appears. 

 
Note:  You can only change Work Area’s using this dialog box.  

2. Click the New Work Area down area and select a letter. 
 

Area A 
 

Jones 

Area B 
 

Garcia 

Area C 
 

Brown 

Area D 
 
 

Area E 
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3. Click OK. 

An information box similar to the one below confirming the Agent 
Assembly Area change appears. 

 
4. Click OK to confirm the switch. 

 

Reorder Segments 

You can change the order of segments in an itinerary.  This is useful for 
itineraries where the segments are not in sequential order. 

You use the Reorder Segments dialog box to change the order of the 
segments.  You can click and drag a segment or use the Move UP and Move 
Down buttons to reorder the segments. 

 

As you reorder segments within the Reorder Segments dialog, the segment’s 
original sequence number is retained.  The sequence numbers are changed 
after you OK the changes.  In the example above, the third segment on the 
itinerary was moved before the second segment.   
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When to use 

Reorder itinerary segments when one or more of them are sequentially 
ordered. 

How to use 

To reorder itinerary segments, complete the following steps: 

1. On the itinerary window, right-click any air segment. 

The segment is highlighted. 

2. Select Reorder Segments from the menu. 

The Reorder Segments dialog box appears. 

3. Click the segment you want to move. 

The segment is highlighted. 

4. Click Move Up or Move Down to change the placement of the 
highlighted segment. 

The segment is moved up or down. 

Note:  You can click and drag the segment within the Reorder Segments 
dialog box instead of using the Move UP and Move Down buttons. 

5. Click OK. 

The segments are reordered on the itinerary window.   
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Summary 

In this module you learned how to: 

• Retrieve a PNR. 

• Explain and use agent assembly areas (AAAs). 

• Reorder segments. 
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Notes 
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Module 11:  Using TravelScreen™ 

TravelScreen™ is an Apollo® solution that will tailor your availability screens 
based on your client's preferences.  You use TravelScreen™ Plus to define 
which vendors your client prefers.  Then, when you request availability for 
air, car, or hotel, the response will only include those preferred vendors. 

TravelScreen™ is also used to append frequently used information to a 
reservation, such as frequent flyer numbers, car and hotel membership 
numbers, airline preferences, forms of payment, and more.  It saves you the 
time of having to type in that information over and over again. 

Module Objectives  

Upon completion of this module you will be able to: 

• Use TravelScreen™ preferences to streamline your business process, 
including activating and deactivating preferences for: 
− Car availability 
− Hotel availability 
− Air availability 

• Apply and transfer TravelScreen™ preferences to the booking 

TravelScreen™ Overview 

For agencies using TravelScreen™, the easiest way to complete the air 
portion of the PNR is to apply TravelScreen™ preferences (pre-stored 
information).  By applying these preferences, you can: 

• Make generic seat requests 

• Append Frequent Flyer numbers 

• Append the preferred form-of-payment 

• Submit special service requests 

When you sell air, car, and hotel segments using TravelScreen™, all client 
information stored in the preference records of the profile is moved into your 
PNR automatically.  This guarantees that your client preferences will be met 
every time. 

Continued on next page 
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TravelScreen™ Overview (Cont.) 

Adding TravelScreen™ to your profiles is optional and consists of different 
preference records, on two different levels: business and personal. 

When TravelScreen™ preferences are active, a TravelScreen button appears 
to the right of the Web button on the toolbar as shown below. 

 

You can control TravelScreen™ preferences using this button or similar 
buttons when searching for air, hotel, and car availability.  The following 
table describes the options on the menu. 

Click this: To: 

Clear Override and turn off preferences. 

Business Activate business preferences. 

Personal Activate personal preferences. 

Merged Merge both Business and Personal preferences. 

Lock Lock preferences so that they remain active at end of booking.  
There may be times when it is desirable to keep same business, 
personal or merged preferences active for a number of new 
bookings. 

Unlock Unlock preferences so that they are cleared at end of booking. 
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Activate and Use TravelScreen™ Preferences 

TravelScreen™ preferences are automatically activated when you move a 
profile with TravelScreen™ preferences into a PNR.  When these preferences 
are activated, Apollo® filters responses so that only the client’s preferences 
are considered.  You can work with any TravelScreen™ preferences that have 
been attached to the profile. 

When TravelScreen™ preferences are activated, the air, car, and hotel 
availability request dialog boxes will appear with a TravelScreen button, 
indicating TravelScreen™ is activated.  With preferences activated, 
Viewpoint™ automatically enters any corporate discount numbers, frequent 
traveler numbers, and frequent flyer numbers on air, car, and hotel 
availability request and sell screens. 

Following is an example of the Car Availability dialog box with the 
TravelScreen button in the lower right corner. 

 

Note:  If you don’t want TravelScreen™ preferences to apply to an 
availability request, check the ‘Neutral Availability’ checkbox. 
 

Continued on next page 
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Activate and Use TravelScreen™ Preferences (Cont.) 

When TravelScreen™ preferences are active, air, car, and hotel availability 
displays will be filtered to the client’s preferences.  The displays will contain 
an active ‘Show TravelScreen Preferences’ (or abbreviated ‘Show Pref.’) 
button. 

The following example shows a Car Availability display with the Show 
TravelScreen Preferences button, indicating preferences are active.  

 

You can click the Show TravelScreen Preferences button to display the 
active preferences. 

Following is an example of clicking the Show TravelScreen Preferences 
button from the above Car Availability display. 

 

This shows that business and personal preferences have been ‘merged’, and 
Alamo and National are the preferred vendors. 



 Module 11: Using TravelScreen™ 

Booking Cars and Hotels using Viewpoint™ Course Book, February 2004 11.5 

In addition to the Show Pref. button, ‘ ’ displays after ‘Availability: 

General’ in an Air Availability screen when TravelScreen™ preferences are 
active.  When you choose to display a neutral display, ‘ ’ displays after 
‘Availability: General’ instead. 

The following Air Availability shows ‘ ’ after ‘Availability: General’ for the 
first flight segment, indicating preferences are active for that segment, and 
‘ ’ for the second flight segment, indicating they are off. 

 

Preferences 
Are 

Active 

Preferences 
Are 

Not Active 
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Deactivate and Reactivate TravelScreen™ Preferences 

When TravelScreen™ preferences are activated, Apollo® filters availability 
displays so that client preferences are considered.  There may be situations, 
however, when you will want to turn off those preferences.  For example, if 
there is nothing available from your client’s preferred vendors, you may want 
to deactivate TravelScreen™ preferences so that you can see what other 
vendor’s have available. 

For cars and hotels, use the ‘Neutral Availability’ check box on the request 
dialog box to deactivate or activate TravelScreen™ preferences.  If you have 
already requested availability, simply update the search and select or deselect 
the ‘Neutral Availability’ check box and re-submit your request. 

You can do the same for air when requesting availability.  In addition, you 
can deactivate and reactivate air preferences directly from an availability 
display. 

Deactivate Air Availability TravelScreen™ Preferences 

When to use 

From an existing Air Availability display, deactivate TravelScreen™ air 
preferences so you can see all vendor availability (neutral display). 

How to use 

To return to the Apollo® neutral display: 

1. Right-click the flight segment head object, and then click Preference Off. 

 
A neutral Air Availability appears. 

Note: The TS indicator on the top right-hand side of the flight segment 
head is crossed, indicating the preferences are switched off. 
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Re-Activating Air Availability TravelScreen™ Preferences 

When to use 

Reactivate air preferences so you can return to TravelScreen™ preferences. 

How to use 

To reactivate the TravelScreen™ preferences from Availability: 

1. Right-click the flight segment head object, and then click Preference On. 

The Air Availability reflecting the TravelScreen™ preferences reappears. 

Transfer TravelScreen™ Preferences to the Booking 

Once an air itinerary is booked from an availability display with 
TravelScreen™ preferences, personal preferences, such as meal requests and 
mileage membership information, can be transferred into the PNR.  This may 
be done on a new PNR or one that you’ve retrieved. 

You apply TravelScreen™ preferences using the following dialog box.  The 
first tab summarizes the stored preferences.  You can make changes by 
selecting the appropriate tab and modifying the preferences.  In the example 
below, there is a seating preference and frequent flyer number. 
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When to use 

Transfer TravelScreen™ preferences after you book an air itinerary from an 
availability display with preferences. 

How to use 

To apply and transfer TravelScreen™ preferences, use the following steps. 

1. Select Append TravelScreen Preferences from the Air menu. 

2. Review the information in the first tab (SPE).  It summarizes the stored 
TravelScreen™ preferences. 

3. Click the tab containing the information you want to change, and make 
the changes. 

4. Click OK to transfer the stored preferences to the PNR/Booking File. 
Keyboard:  Press Enter. 

As appropriate, information such as seats requests, mileage membership 
details, and Special Service Requirements (SSRs) are added to the 
Booking File for transmission to the carriers at end transact. 

Use this tab: To provide: 

Special Service 
Requests 

Special service requirements together with any 
appropriate text. 

Form of Payment 
Choices 

Default form of payment for air tickets, car rental 
deposits, and hotel reservation deposits/guarantees. 

Quick Seat 
Assignments 

Seating preferences.  These can be applied to 
selected or all segments with unassigned seats. 

Mileage Membership Club membership numbers that your client has with 
air carriers. 
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Summary 

In this module, you learned how to: 

• Use TravelScreen™ preferences to streamline your business process 
including activating and deactivating preferences for: 
− Car availability. 
− Hotel availability. 
− Air availability. 

• Apply and transfer TravelScreen™ preferences to the booking. 
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Notes 
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Module 12:  Customizing Viewpoint™ 

There are several Viewpoint™ tools that you can use to enhance your 
proficiency and customize Viewpoint™ to the way you work.  This module 
introduces you to a few of these tools. 

Module Objectives 

Upon completion of this module, you will be able to: 

• Customize the itinerary window. 

• Change the view to minimum or maximum. 

• Change several Viewpoint™ options. 
 

Customizing the Itinerary Window 

You can customize various parts of Viewpoint™ to the way you work, 
including how PNRs display on the itinerary window.  To customize 
Viewpoint™, you use the Viewpoint Options dialog box.  You access the 
Viewpoint Options dialog box from the Tools menu. 

 

Each tab on the dialog box allows you to customize a part of Viewpoint™.  
This section focuses only on the PNR tab. 

Continued on next page 
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Customizing the Itinerary Window (Cont.) 

Using the PNR tab, you can change how PNRs display in the itinerary 
window.  You can change the following: 

• Which fields of the PNR display 

• The order in which the PNR fields display 

• The default levels at which fields display (expanded or collapsed) 

• Whether to use TravelScreen™ 

• Whether to close all open windows with a new PNR 

By default, Viewpoint™ displays PNR fields in a specific order and at a 
certain level of detail.  The example below shows that by default, the first 
three fields on the itinerary window are Names, Phones, and Itinerary.  Also 
notice that Phones is expanded, enabling you to see the different phone 
numbers. 

. 
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You can change the order of PNR fields and level of detail displayed.  In the 
example below, the Addresses field displays after the Phones field, and the 
Phones field by default is collapsed. 

 

To change the itinerary options, you use the PNR tab of the Viewpoint 
Options dialog box. 

 

Continued on next page 
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Customizing the Itinerary Window (Cont.) 

The PNR tab displays the fields in the order in which they will display on the 
itinerary window.  A text description indicates at which level a field displays.  
A checkmark indicates those fields selected to display on the itinerary 
window. 

In the example above, all fields except for Document Numbers are selected 
for display and will be expanded to the item’s first level by default.  
Document Numbers is set to not display on the itinerary window. 

You use the buttons on the right side of the dialog box to change a field’s 
itinerary display characteristics. 

The dialog box also has two checkboxes that enable TravelScreen™ options 
and control whether or not open windows, such as air or car availability, are 
automatically closed when you work with a new PNR.  When active, 
TravelScreen™ preferences are applied instantly to air, car and hotel 
availability displays, editing the displays to the client's requirements.   

When to use 

Customize the itinerary window display when you want to change the way a 
PNR field displays. 

How to use 

To change the way Viewpoint™ displays a PNR, use the following steps. 

1. From the Tools menu, select  Options. 

The PNR tab of the Viewpoint Options dialog box appears. 

2. Click the field that you want to change. 

3. Do one or more of the following: 
a. To remove a field from the itinerary window, click Exclude. 
b. To display a field that has been removed from the itinerary window, 

click Include. 
c. To change the position of the field, click Move Up  or Move Down. 
d. To change the level at which the field displays, click  one of the 

buttons: 
− Not expanded—to display the field fully collapsed. 
− Expand to 1st Level—to display the first level. 
− Expand to All Levels—to display the field fully expanded. 

e. To apply TravelScreen™ preferences, select the TravelScreen check 
box. 

f. To close all windows with a new PNR, select the Close all windows 
with a new PNR check box. 
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4. Click OK to apply your changes. 

The itinerary window refreshes with your changes in effect.  The changes 
remain in effect until you change them back. 

Practice 

Make the following display changes to your itinerary window: 

1. Display Phones after the Itinerary. 

2. Do not show Profile Associations. 

3. By default, do not expand Ticketing Arrangement. 

Change to Minimum or Maximum View 

By default, Viewpoint™ displays the maximum amount of information on all 
of the windows that you work with, including the itinerary window, air 
availability window, and hotel availability window.  

Below is an example of a round trip with a car and hotel displayed in 
“maximum” view on the itinerary window. 

 

You can change the view to a “minimum” view.  For example, if you are 
working with an itinerary that contains a number of air and hotel segments, 
you might want to change the view to the minimum so that you can see more 
segments at once. 
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To change to a minimum view, select Minimum from most any View menu 
as shown below... 

 

…and the itinerary window changes to a minimum display. 

 

To change back to a maximum view, select Maximum from the View menu.  
Your selection, minimum or maximum, applies to all Viewpoint™ windows.  
It remains in effect until the next time you change it. 
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Change Viewpoint™ Options 

You can customize various parts of Viewpoint™ to the way you work.  To 
customize Viewpoint™, you use the tabs on the Viewpoint options dialog 
box. 

 
The following table summarizes what the tabs do on the Viewpoint Options 
dialog box. 

Use this tab: To do this: 

PNR Change how PNR displays on itinerary window. 

Hotels Change order in which hotel rules display. 

PRO-file Change how profiles display. 

Hints Turn hints on or off.   

Air Change which button on air availability requests is default (when 
the Enter key is pressed), Search or Add.   

Maps Change where Viewpoint™ looks for Maps files. 

Custom 
Reference 
Points 

Change where Viewpoint™ looks for custom reference point file,  
file you create while using the maps and airport layouts that can 
be opened from Viewpoint™. 

Tour Change where Viewpoint™ looks for the Touring Viewpoint™ 
training course. 

Fare Quote Change default Fare Quote Type (Best Buy, Best Buy Quote™, 
etc.) and default commission. 
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Use this tab: To do this: 

Ticketing 
Modifiers 
Favorites 

Add your most often used ticketing modifiers to the Ticketing 
Modifiers Favorites tab. 

Ticketing Select action to take in case of an Electronic ticket failure, issue a 
paper ticket or cancel issuance. 

Web Add an additional web site and change the way it displays, if 
available. 

Scripts Automatically launch scripts at five specific actions in booking 
process: after any air, car, or hotel sell and after you click Finish 
or move a profile.  You must have Scriptwriter Plus™ installed on 
your computer. 

The following sections describe how to change three Viewpoint™ options: 

• Hotel Rules Display 

• Hints on or off 

• File Locations 

Change Hotel Rules Display 

The Hotels options allow you to determine the default order of both 
RoomMaster® and Inside Availability® rules.  Inside Availability® vendors 
are able to display rules that apply to the room rate directly from their own 
computer system.  For vendors that are not showing Inside Availability®, 
rules are displayed from RoomMaster®. 
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Rules can be viewed after displaying the Complete Rates for a selected 
property.  Below is an example of the default order in which Viewpoint™ 
displays rules for an Inside Availability® vendor. 

 

You can change the default order in which rules are shown.  For example, 
you could display Guarantee and Deposit information first. 

When to use 

When you want to see RoomMaster® and Inside Availability® rules in a 
specific order, change the default order. 

How to use 

To change the order of hotel rules, use the following steps. 

1. From the Tools menu, select  Options. 

2. Click the Hotels tab. 
 



Module 12: Customizing Viewpoint™   

12.10 Booking Cars and Hotels using Viewpoint™ Course Book, February 2004 

The Hotels tab appears. 

 
3. Click the Options button for either the RoomMaster Rules Display or 

Inside Availability Rules Display. 

The Rules Options dialog box appears. 

 
4. Select an option to move. 

 

Continued on next page 
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How to use (Cont.) 

5. Click the Move Up or Move Down button. 

6. Click OK. 

7. Click OK. 
 

Turn Hints On or Off 

Hints are the messages that give advice before using particular windows and 
dialog boxes. 

For example, when hints are turned on and you display the Air Availability 
Request window, a hint is displayed. 

 

Individual hints can be turned off by clicking their own Do not display this 
hint again check box.   

Once you become familiar with using Viewpoint™, you might want to turn 
off all Viewpoint™ hints. 
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When to use 

Turn hints on if you are a new Viewpoint™ user; turn hints off if you are an 
experienced user. 

How to use 

To turn hints on or off, display the Hints tab and click the appropriate button. 

  

Change File Locations 
 

Once Viewpoint™ is installed on your computer, it works seamlessly without 
you or your administrator having to make any technical changes. 

Viewpoint™ does, however, give you or your administrator the flexibility of 
installing several files anywhere on your computer or network. 

You can tell Viewpoint™ where to look for the following files: 

• Maps—the files associated with the optional product Maps. 

• Custom Reference Points—the file you create while using Maps and 
airport layouts that can be opened from Viewpoint™. 

• Tour—the files for Touring Viewpoint™, the computer-based training 
course that introduces new users to the booking process. 

Each of these has its own tab on the Viewpoint Options dialog box where 
you can specify where to look for these files.  You or your system 
administrator will most likely set these only once. 
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When to use 

When required, change the location where Viewpoint™ looks for Maps, 
Custom Reference Points, or Touring Viewpoint™ files. 

How to use 

To specify the location of Maps, Custom Reference Points, or Touring 
Viewpoint™ files, complete the following steps: 

1. From the Tools menu, select  Options. 

The PNR tab of the Viewpoint Options dialog box appears. 

2. Click the Maps, Custom Reference Points, or Tour tab. 

3. Type the path or c lick the Browse button to specify the location of the 
files. 

4. Click OK. 
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Summary 
 

In this module, you learned how to: 

• Customize the itinerary window. 

• Change the view to minimum or maximum. 

• Change select Viewpoint™ options. 
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Appendix A:  Module Practice Answers 

This appendix contains the answers to the Practice questions in the modules 
throughout the course book.  Use it to check your answers. 

Module 2: Getting Started 

Display Context-Sensitive Help 

Sign on to Viewpoint™ and display the Itinerary window.  Display context-
sensitive help.  What is the name of the Help topic that is displayed? 

Answer:  To display context-sensitive help from the Itinerary Window, press 
F1.  The following Help topic appears: 

 

Display General Help 
1. Use the Viewpoint Help Content tab and look up the glossary definition 

for ‘AAA’.  What does it stand for? 
Answer:  Agency Assembly Area 

2. Use the Viewpoint Help Search tab and search for ‘AAT’.  What does it 
stand for?  
Answer:  Agency Account Table 
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Module 3: Building a Basic PNR 

Create a new PNR for your customer who lives and works in your city.  Use 
your name for the customer unless instructed otherwise.  Add your name and 
a work telephone number, 555-1717.  Add your agency telephone number as 
well. 

1. Display your name on the itinerary window. 

Answer:  To create a new PNR, select Create/Edit Customer Information-
Name from the Customer menu.  Type your last name in the Last Name text 
box and your first name in the First Name text box.  Click Add.  The Name 
tab of the Customer Information dialog box should look similar to the one 
shown below, where we are using Chris Zachs as the customer. 
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Press Ctrl + Tab twice to display the Phone tab.  Type your city code in the 
City Code text box or select it from the list, select Travel Agent as the Type, 
and enter a telephone number in the Phone Number text box.  Click Add.  
The Phone tab of the Customer Information dialog box should look similar to 
the one shown below. 

 

Perform similar steps to add the business telephone number, selecting 
Business as the Type.  After clicking Add, click OK. 

 

Continued on next page 
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Building a Basic PNR (Cont.) 

The name and phone numbers are added to the Itinerary window.  Note that 
in our example the title bar now shows PNR – ZACHS. 

 
2. Add a home telephone, 581-8282. 

Answer:  To add the home telephone number, right-click on the Phones 
section or click the Customer button and select Create/Edit Customer 
Information – Phone.  Add the home phone, selecting Residence as the Type. 
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3. Change the work telephone to 555-2179. 

Answer:  To change the work telephone, click the Business phone to 
highlight it, make the changes in the Phone Number text box, and click 
Modify.  Then click OK. 
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Module 4: Adding Agency, Company, and Traveler Information 

Move Profiles 

Use Viewpoint™ to perform the following tasks. 

1. You are making a reservation for a new customer, Joey Sanchez.  You 
have no information on file yet.  Move your agency file to include the 
agency phone number with your name.  Type the customer’s first name 
for the Received field. 

2. Ignore the PNR. 
 

Answer:  Select Get PRO-file from the Customer menu.  Type Joey in the 
Received from text box and click the Move Agency Only button. 

Display Profiles and Move Selected Lines 

Use Viewpoint™ to perform the following tasks. 

1. Display your agency profile. 

Answer:  Select Get PRO-file from the Customer menu.  Type a name in the 
Received from text box and click the Display button. 

2. Providing there is more than one line available to move, change one of 
lines to move or not move (e.g., change a line that is selected to move so 
it doesn’t move). 

Answer:  Click the green check mark to prevent a line from moving.  Click 
an empty check box to move an optional line. 

3. Move the agency profile. 

Answer:  Click the Move button and select Agency Only. 

4. Ignore the PNR. 
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Module 5: Selling Cars 

Reference Sell 

Use the PNR you started in Module 3.  Your customer will be in Chicago six 
months from now and needs a car.  Your customer wants to pick up the car at 
O’Hare airport Tuesday morning at 10:00 and drop it off Thursday afternoon 
at 4:00.  Your customer prefers Hertz intermediate sized cars with unlimited 
mileage.  Your customer doesn’t have a corporate discount number and 
wants the least expensive car. 

1. Display low-to-high availability. 

Answer:  From the Car menu, select Availability.  The Car Availability 
dialog box appears.  The Basic Fields tab of the Car Availability dialog box 
should look similar to the following. 

 

Continued on next page 
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Reference Sell (Cont.) 
The Rate Categories tab should look similar to the following: 

 
Click the Search button.  The Car Availability window appears.  

2. Display the rules for the least expensive car. 

Answer:  From availability, select the car with the lowest fare and click the 
Rules button.  A window similar to the following appears. 
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3. Sell the least expensive car. 

Answer:  Click the Sell button.  The Sell dialog box appears. 

4. Add a special service request indicating that the customer requests a non-
smoking car. 

Answer:  The Special tab should look similar to the following before clicking 
Sell: 

 
5. Display the Itinerary to view the car segment. 

Answer:  Click Itinerary.  The screen should look similar to the following: 
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Display Car Descriptions 

Use the PNR from the previous car practice (Chicago, Hertz intermediate 
sized car).  Display shuttle information for the location that you have booked. 

Answer:  Select the car segment.  Then, select ‘Description’ from the Car 
menu.  The Car Description window appears.  Double-click the ‘SHTTL 
SHUTTLE SERVICE’ Keyword.  The Car Description should look similar to 
the following: 
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Modify a Car Segment 

Use the PNR from the previous practice (Chicago, Hertz intermediate sized 
car). 

1. Your customer’s plans have changed.  Modify the car segment, changing 
the car from an intermediate to a standard sized car. 

2. Sell any Hertz standard sized car. 

Answer:  Highlight the car segment.  Then select Modify from the Car menu.  
The Car Modify dialog appears.  Change the Size to standard.  The Car 
Modify dialog box should look similar to the following: 

 

Click the Check Availability button to see if the standard car is available.  
The Car Type Availability window appears.  Click a standard car.  Click OK, 
then click Modify to rebook the car segment.  The Sell, Modify, Cancel – 
Vendor Summary window appears. 
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Cancel a Car Segment 

Use the PNR from the previous practice (Chicago, Hertz standard sized car).  
Cancel the car segment. 

Answer:  Select the car segment.  Click the Customer button and select 
‘Cancel Segment(s)’.  A confirmation dialog appears.  Click Yes to confirm 
the cancellation.  The Sell, Modify, Cancel – Vendor Summary window 
appears.  It should look similar to the following: 
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Direct Sell 

Your customer will be in San Francisco six months from now.  Your 
customer wants to pick up a car at the airport Monday morning at 10:00 and 
return it Wednesday afternoon at 3:00. 

1. Direct sell a car.  Your customer would like a 2/4 door, intermediate size 
with Avis.  Sell the car using A123456 as the corporate discount number 
or one provided by your instructor. 

Answer:  Select Direct Sell from the Car menu.  Complete the Vendor, Corp 
Discount#, and Car Type.  The Car Direct Sell should look similar to the 
following. 

 

Click Sell.  The Sell, Modify, Cancel – Vendor Summary window appears. 

Continued on next page 
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Direct Sell (Cont.) 
2. Display the itinerary. 

Answer:  Click the Itinerary button to display the sold segment.  The 
itinerary should look similar to the following: 
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Module 6:  Saving and Ignoring a PNR 

Save a PNR 

Save the PNR from previous modules.  Re-retrieve the PNR after it has been 
saved. 

Answer:  From the itinerary window, click the Finish button and select Save 
PNR.  The Save PNR dialog box appears.  Type a name in the Received text 
box.  Make sure the ‘Re-retrieve this PNR after it has been saved’ check box 
is selected.  The Save PNR dialog box should look similar to the following 
before clicking Save. 
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Ignore a PNR 

Ignore the PNR from previous practices. 

Answer:  Ignore a transaction by selecting Ignore from the Finish or 
Customer menu.  You should receive the following dialog box when ignoring 
a transaction. 
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Module 7:  Selling Hotels 

Create a new PNR for your customer.  Enter your name in the name field (as 
the customer) unless instructed otherwise. 

1. Display a Hotel Index for a hotel near Manhattan Beach, near LAX 
airport, for six months from now beginning with Monday night for six 
nights.  Search for hotels that are under $175.00 per night and have an 
outdoor pool and meeting rooms. 

Answer:  Select Index from the Hotel menu.  Enter the In and Out dates, and 
enter LAX in the City or Airport text box.  Click Reference Point, and select 
‘Manhattan Beach’.  The Basic Fields tab should look similar to the 
following. 

 

Continued on next page 
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Selling Hotels (Cont.) 

The Features tab should look similar to the following. 

 

The Others tab should look similar to the following. 

 

Click Search.  The Hotel Index results window appears. 
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2. Access a complete list of available rates for the third hotel listed. 

Answer:  From the Hotel Index display, click the third hotel listed.  Then 
click the Complete button.  A Complete Availability window similar to the 
following appears. 

 

Continued on next page 
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Selling Hotels (Cont.) 
3. Check the rate rules for the least expensive room rate that the customer 

can use. 

Answer:  Select a room, and then click the Rules button.  A Rules Display 
similar to the following appears. 
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4. Sell the hotel using the American Express card ( 370000000000028  
expiration 12/05) for the guarantee. 

Answer:  Click the Sell button.  Enter the guarantee information.  The Hotel 
Reference Sell dialog box should look similar to the following. 

 

Click Sell. 



Appendix A: Module Practice Answers  

A.22 Booking Cars and Hotels using Viewpoint™ Course Book, February 2004 

Module 8:  Using Maps 

Determine Distance Between Points 

You are working with a customer who wants to book a hotel near the Art 
Institute in downtown Chicago six months from now. 

1. Search for hotels within a mile of the Art Institute of Chicago. 

2. Mark the first, third, and fifth hotels for plotting on a map. 

3. Display the map. 

Answer:  The map should display with the first, third, and fifth hotel selected 
as shown below. 
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4. Plot the Art Institute of Chicago on the map. 

Answer:  Select Attractions from the Plot drop-down arrow list.  Double-
click Art Institute of Chicago.  The map display should look similar to the 
following. 

 

Continued on next page 
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Determine Distance Between Points (Cont.) 
5. Your customer asks how far the Art Institute is from Union Station.  Find 

the distance between these two points. 

Answer:  Click Distance and select Miles.  Then click Distance and select 
Distance.  Move the pointer over one of the points and click, and while 
holding the mouse button down move the pointer over the second point. 
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Create Custom Reference Points 
1. Search for a map of South Lake Tahoe.  Display the map. 

Answer:  Click the Map button and select Search.  Complete the Map Search 
dialog box as shown, then click OK. 

 

Continued on next page 
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Create Custom Reference Points (Cont.) 
2. Add the custom reference point, ‘Heavenly Resort’, to the lower right 

portion of the map, somewhere near where Saddle and Wildwood roads 
intersect.  Optionally, add a fictitious address and telephone. 

Answer:  Select Insert Custom Reference Point from the Map menu.  Move 
the pointer over the lower right corner of the map and click the mouse button.  
Type at least the name in the Custom Reference Point dialog box as shown.  
Then click OK. 

 

The map should look similar to the following. 
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3. Display the name of your custom reference point by pointing to its 
number. 

Answer:  Move the point over the custom reference point number. 

 
4. Change the ‘Heavenly Resort’ custom reference point name to ‘Heavenly 

Ski Resort’. 

Answer:  Select Manage Custom Reference Points from the Options menu.  
Click the name, and then click Edit. 

 

Change the name and click OK. 



Appendix A: Module Practice Answers  

A.28 Booking Cars and Hotels using Viewpoint™ Course Book, February 2004 

Module 9:  Adding Optional PNR Fields 

Add and Change PNR Remarks 

Use the PNR that you saved in Module 6 (Avis intermediate size in San 
Francisco). 

1. Associate the following remark to the car segment: HAVE A SAFE 
TRIP 

Answer:  Select Create/Edit PNR Remarks – Associated from the Customer 
Menu.  On the PNR Remarks dialog box, select the car segment by clicking 
it.  Type the remark in the Remarks Text field.  Click Add.  The PNR 
Remarks dialog box should look similar to the following. 
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2. Add the following remark to the itinerary (unassociated):  THANKS 
FOR YOUR BUSINESS 

Answer:  Click the Unassociated tab.  Type the remark in the Remarks Text 
field.  Click Add.  The dialog box should look similar to the following. 

 
3. Add a queue minder for two days from now to queue 30: CHECK FOR 

UPGRADE AVAILABILITY 

Answer:  Click the Queue Minder tab.  Enter a date, 30 in the Queue text 
box, and your pseudo city code.  Type the remark and click Add.  The PNR 
Remarks dialog box should look similar to the following. 

 

Continued on next page 
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Add and Change PNR Remarks (Cont.) 
4. Add the following postscript message:  APPROVAL PENDING 

Answer:  Click the Customer ID/Postscript tab.  Type the remark.  The PNR 
Remarks dialog box should look similar to the following. 
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Module 10:  Working with PNRs 
 

Retrieve a PNR 

Retrieve Chris Zachs’ PNR by name. 

Answer:  Click the Customer button and select Retrieve PNR.  The Retrieve 
PNR dialog box appears.  Type the last name in the text box.  The Retrieve 
PNR dialog box should look similar to the following: 

 

Click OK. 
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 Module 12:  Customizing Viewpoint™  

Customize PNR fields on Itinerary Window 

Make the following display changes to your itinerary window: 

1. Display Phones after the Itinerary. 

Answer:  Select Options from the Tools menu.  Click Phones, and then click 
the Move Down button.  The Viewpoint Options should look like the 
following. 
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2. Do not show Profile Associations. 

Answer:  Click Profile Associations, and then click Exclude.  There should 
not be a checkmark next to Profile Associations as shown below. 

 
3. By default, do not expand Ticketing Arrangement. 

Answer:  Click Ticketing Arrangement, and then click Not Expanded as 
shown below. 
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Notes 
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